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1.0 General introduction

@ The Eachine V-tail 210 is a very cool FPV Racing drones. The unique shape and cool painting makes it
stand out from the crowd. With a new V-tail body design and carbon fiber material , it has superior
ruggedness and anti-drop ability.

@® The Eachine V-tail 210 based on SP RACING F3 EVO -- the new generation hardware platform, which
can provide Jaw-Dropping Flight Performance. Internal ARM Cortex-M4 72Mhz CPU with Math
co-processor (FPU) for efficient flight calculations that gets more done in less time. It means that the
Loop times up to ~2x as fast as previous-generation STM32F1 based boards

® The Eachine V-tail 210 employed the acclaimed EMAX RS2205 motor with Emax Lighting 20A ESC which
running BLHELI latest firmware, so the aircraft has super-fast response and superior power, and bring

you a very pleasant FPV flying experience.

ARF Version 1
SRl ARF Version 2

N

RTF Version 1 RTF Version 2

¢

A Foryour safety, and avoid accidents, You must remove all the propellers when you connect the

V-tail 210 to computer
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2.0 Specification

Main Rotor Dia:127mm

Overall(Lx W x H):224 x188 x 75
Weight:560g(include battery)

Camera: 1080P HD 90°Camera
Propeller: Gemfan 5045BN

Remote controller: Eachine 16 (Optional)
Receiver: Eachine X6 (Optional)

GPS: 7M GPS (Optional)

OSD:MWOSD R1.6

Main Controller :SPRACING F3 EVO
Video transmitter:TX58200 40CH 200mw
Brushless Motor: EmaxRs2205 KV2300
Brushless ESC: Emax 20A

Battery: Eachine 4S 1500MAH 50C

Flight controller specification:

CPU STM32F303CPU,72Mhz inc FPU

Accelerometer MPU9250 accelerometer/gyro/compass (connected via SPI)
Barometer BMP280

Micro SD card slot SD/SDHC, up to 32GB

Size 23mm*28.5mm*5mm

Weigt 49

Firmware release

Cleanfilght SP Racing F3 EVO R1.13.0

Motor Specification:

Emax RS2205

KV 2300
Configuration 12N14P
Diameter 27.9mm
Length 31.7mm
Shaft Diameter 3mm
Weight(g) 29

Idle current(10)@10V(A) 0.35
No. of Cells(Li-po) 2~4S
Max Continuous Power(W)180S 135
Internal Resistance 118mQ
Max Current(180S) 12A

Max.Effciency Current

(2-7A)>83%

@ ESC Specification:

Emax lightning-20A,support Li-po Battery: 2s-4s

Continuous current 20A,Burst current: 30A(10s)
Oneshot125 Ready,Damping light Ready
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Camera specification:

Video format: NTSC or PAL Switchable
Effective pixel: 1920(H)x1080(V)
Sensor:1/3 inch HD CMOS

Focal length:3mm

Lens angle: H:90 degree V: 90 degree
Working voltage: 5V

Working current: 80mA

Weight: 49

HMDVR-HD Specification:

Video format: NTSC or PAL Switchable
Records Effective pixel: 1920(H)x1080(V)
Records Frame rate:60Frames

Compress Format: MOV

Video Output size:640x480

Size:50mm x 22mm

Weight:6g

Max support 32G TF Card,Suggest Class10

Video IN

Micro SD Card slot

Video DUQ

Auto-save function: Auto-save every 5 minutes

5.8G 40ch 200mw Video transmitter Specification:

Wireless Channel: 40CH
Modulation : Broadband FM
Support Video Format: NTSC/PAL
Video input impedance : 75 Ohm
Audio input impedance:10K Ohm
Output Signal : 23~24dBm
Output Power : 400mw(Max)

123456

Remove the Airplane
protective guard, and
move the DIPS 1/2/3/4/5/6 to
change the channel

Dips 1-2-3-4-5-6 are"on"

Working voltage: 5V

Working current: 500mA
Connector: RPSMA Connector
The default channel is 5917

123456

Dips 1-2-3-4-5-6 are"off"
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3.0 Get to know the parts of V-tail 210

5045BN Prpeller

V2105 Camera
V2102ESC
&Cautions Propeller Installation
the side which marked characters must be up

5045BN

- Black Nut _~Silver Nut

5045BNR
@/ \%somm

v2101cW vz1u1ccw\é
v2102

V2116 V2102
%’3 V2116
V2127 e Iy SSsi———lLP 14

v 1, !

v2125\®
14 111
V2123 v2123

V2128

V2121

Nvmze

~V2139R
V2118 (Optional)
V2106

V2105 y2138

V2111
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Parts List

Part description Part NO Part description Part NO
Emax RS2205 KV2300 CW Motor V2101CW | Airplane mounted frame V2120
Emax RS2205 KV2300 CCW Motor V2101CCW | V-tail arm protection guard V2121
Emax Lightning 20A ESC V2102 V-tail arm Reinforcement part V2122
GEMFAN 5045BN Propeller 5045BN Frontlanding gear V2123
GEMFAN 5045BNR Propeller 5045BNR Rear landing gear V2124
SP RACING F3_EVO Flight controller V2103 Motor protection guard V2125
PDB_OSD Main board V2104 Rear LED guard V2126
1080P Camera V2105 Front LED module V2127
HMDVR-HD 1080p V2106 Rear LED module V2128
5.8g 40ch 200mw wireless video transmitter V2107 Aluminum hexagonal columns V2129
5.8g Antenna V2108 Aluminum Studs V2130
Eachine 7M GPS V2109 Battery cable ties V2131
Bluetooth module V2110 Screws combo V2132
Eachine 4S 1500mAh 50c battery V2111 Allen wrench V2133
Charsoon DC-4S Blance charger V2112 DSM Cable+ PPM/SBUS Cable V2134
Bottom carbon board V2113 PPM Cable for Eachine X6 receiver V2135
Rear carbon board V2114 Velcro tape V2136
Top carbon board V2115 Sponge damping for camera V2137
Front carbon arm V2116 Connection cable for Camera V2138
Rear carbon arm V2117 Eachine I6 transmitter V2139T
Camera mount V2118 Eachine X6 Receiver V2139R
Airplane protective guard V2119

PDB_OSD Main board Connection diagram

Video Ir

o]
il

s

GND +5V vigeo

F3 configure
UsE Port

Video Out

Videa +5v GND

A1

RX3 GND +3.3V

=~Front LED

Rear LED

® VIDEO IN: Cameravideo in
® VIDEO OUT: 5.8G VTX video out

® F3 Configure USB Port: Connect to computer, accept Cleanflight and Betaflight.
® OSD Configure USB Port: Connect to computer, configure OSD with MWOSD GUI, must power the battery.
® UART2 : Used for PPM/SBUS Receiver input or GPS
® UART3: Used for GPS or Telemetry module, unavailable when DSM Input used

® DSM INPUT: Used for DSM/DSM2/DSMX Receiver input, unavailable whenUART3 used

-5-
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4.0 Get to know your remote controller(Optional)

@ There is a Remote controller comes with the RTF version.

® The V-tail 210 feature 2 useful flight modes, STABILIZE / ADVANCED(Rate mode) Flight modes are
selected by the MIX switch(SWB)
*Select the appropriate mode according to your flight skills
*For your first test flight with a new quad, always start with the STABILIZE mode

Left stick THRO/RUDD stick STABILIZE ADVANCED
MODE 2 e . Flight Mode Flight Mode
(Throttle stick Right stick ELEV/AILE stick
on the left) Left trim THRO trim
Right trim ELEV trim 1 1A
L] u
Leftstick | ELEV/RUDD stick Y Y
MODE 1 Right stick | THROYAILE stick
(Throttle stick i -
. Left trim ELEV trim 3 5
on the right) MIX Switch to “2” MIX Switch to “1”
Right trim THRO trim

. Handle

. Antenna
. Switch A
. Switch B
Switch C
. Switch D

. Leftstick
. Lefttrim

O 00 N o u b W N

. Righttrim
. Rightstick
. Lefttrim

=
o

=
N P

Right trim
. Up

I
Hoow

. press the Enter key

=
ul

. Down

=
o3}

. Short press the Cancel key

=
~

. Code keys
. Switch
. LCD Display

[y
o)

=
o
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5.0 Receiver Configure (ARF Version)

The V-tail 210 ARF Version need a receiver and radio controller, V-tail 210 support
PPM/SBUS/DSM/DSMX receiver input.
® PPM Receiver configuration

Plug the PPM receiver to UART2 port, then set receiver mode to RX_PPM in Cleanflight configurator.

Ports DOCUMENTATION FOR 1.13.0

Note: not all combinations are valid. When the fllght controller firmware detects this the seral port ccr:fuguranon will be reser
Note: Do NOT disable MSP on the first serial port unless you know what you are deing. You may have 10 reflash and erase your configuration if you
do

ienuter | Dat Loggg ___

usevcr i Mse | 115200 v Blackbox. 115200 v Disabled + AUTO = I Serial R

UARTI @ MsP | 115200 ~ 0 Biackbox | 115200 ¥ | | Disabled v [|AUTO + I senal x| (i [STe00 ~
UART2 b Mse (115200 w1 (b Blsckvox (115200 ¥ | [Disabled v |[AUTO v | (B SenatRX () (57600 v
UART3 T MsP | 115200 ¥ 1 Biackbox | 115200 v Disabled * | AUTO *» N Serial R (ju 57600 *

Receiver Mode

® RX_PPM PPM RX input

) RX_SERIAL Serial-based receiver (SPEKSAT, SBUS, SUNMDY)
' RX_PARALLEL_PWM PWN RX input {one wire per channel)
' RX_MSP MSP RX imput (control via MSP part)

Serial Receiver Provider

Note: Remember to configure 3 Serial Port (via Ports tab) and choose 3 Serial Recaiver Provider when using
RX_SERIAL feature.

: RUM1024 -

SPEKTRUM2048

SBUS

SUMD

SUMH

XBUS_MODE_B

)(BUS MODE B _RJ01

IBUS - |

- www.eachine.com
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@® SBUS Receiver configuration
Plug the SBUS receiver to the UART2 port, Then Enable Seria_RX for UART2 and Set Receiver mode to
RX_SERIAL. Select SBUS signal in Cleanflight configurator.

Ports DOCUMENTATION FOR 1.13.0

Nate: not all combinations are valid, Wnen the flight controller firmware detects this the senal port configuration will be reser
Note: Do NOT disable M5# on the first serial port unfess you know what you are doing You may have 1o reflash and erase your configuration if you
do,

ot | o [oas tseney CE

usevee (@) Mse (115200 ¥ 0 Blackbow [ 115200 ¥ [ Disabled ¥ [AUTO ¥ W serial R () [57600 ¥
usk @M (115200 v | o JE Blackbox | 115200 Disabled v || AUTO P serial RX (T [57600 ¥
UARTZ  (JIb MsP | 115200 v T Biackoox | 115200 Disabled v | AUTO v| (@[)SenalfX (7] 57600 ¥

UART2 JBD MsP | 115200 v 5 Blackbox | 115200 v Disabled ¥ |AUTO v B Serial RX @) 57600 v

Receiver Mode

RX_PPM PPM RX input
® RX SERIAL Serial-based receiver (SPEKSAT, SBUS, SUMD)
| RX_PARALLEL_PWM PWM RX input {one wire per channef)
L RX_MSP MS5P RX input {control via M5P port)

Serial Receiver Provider

Note: Remember to configure a Serial Port (via Ports tab) and choose a Serial Receiver Provider when using
RX¥_SERIAL feature.

SPEKTRUM1024 7
SPEKTRUM2048
)
SUMD

SUMH

IXBUS MODE_B

[XBUS MODE_B_RJO1

IBUS -

www.eachine.com -
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@ DSM/DSM2/DSMX Receiver configuration

Plug DSM/DSM2/DSMX receiver to the DSM Port, Enable Seria_RX for UART3 and Set Receiver mode
RX_SERIAL ,Select Spektrum1024(DSM/DSM2) or Spektrum2048(DSMX) in Cleanflight configurator.

A\ Please Connect GPS to UART2 when you used DSM/DSM2/DSMX Receiver

Note: not all combinations are valid. When the flight controller firmware detects this the serisl port configuration will be reset.

do

usevce il )MsP | 115200 ¥ _JI Blackbox | 115200 ¥ Disabled AUTO JI Serial RY

UART1 @ MsP | 115200 v I Blackpox | 115200 » Disabled * | AUTO - ) Serial RX )
UART2 I MsP | 115200 J Blackbox | 115200 * Disabled * [AUTO = T ceral i )
UART3 I MsP | 115200 ¥ I Blackbox | 115200 ¥ Disabled ¥ AUTO v @) serial X

Ports DOCUMENTATION FOR 1.13.0

Note: Do NOT gisable MSP on the first serial port uniess you know whnat you are doing, You may have o refiash and erase your configuration if you

57600 *
ET600 -
57600 v

57600 v

Receiver Mode

RX_PPM PPM RX input
® RX_SERIAL Serial-based receiver (SPEKSAT, SBUS, SUMD])
| RX_PARALLEL_PWM PWM RX input {one wire per channel)
| RX_MS5P MSP RX input {control via MSP port)

Serial Receiver Provider

RX_SERIAL feature.

SPEKTRUM2043
SBUS

SUMD

SUMH
XBUS_MODE_B
XBUS_MODE_B_RJO1
IBUS

Note: Remember 10 configure a Serial Port (via Ports tab) and choose a Serial Receiver Provider when using

SPEKTRUM1024 -
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6.0 A Attention before flight

*The V-tail 210 Quadcopter is recommended for piots,14 years or older, with RC hobby experience.

+Only fly the V-tail 210 in dry weather, with low wind, please do not fly in rain or heavy foggy conditions.
«Always choose large open fields for flying. Check local LAW and ordinances for legal flying areas.
«Always keep at least 10 feet distance to the aircraft when armed, to avoid injury from high-speed
propellers on the ground or while flying. Always disarm before handling the aircraft.

«Do not fly close to high-voltage power lines, cell phone towers, or radio towers, as these may disrupt
your control signal.

*ALWAYS check local laws BEFORE flying. NEVER fly over crowds, concerts or sports stadiums.

7.0 Charge the battery

«Connect the power cable to the wall-outlet, the power adapter accept voltage from 100V to 240V.
When correctly powered the charger LED Screen will be display

Insert the Lipo battery balance plug into the Charsoon DC-4S charger

«During charging the Led screen will display total battery voltage and single cell voltage cyclically.
When charging is completed, the total voltage should be 16.8v(+0.1v~0.2v) in the LED Screen.

A IMPORTANT ISSUE YOU MUST PAY ATTENTION TO:

*The DC-4S Charger can ONLY used for 2s/3s/4s batteries.

NEVER EVER attempt to charge more than one battery at any time, the charger may get damaged or
catch fire.

«During charging, the DC-4S should be placed in a dry and ventilated place, far away from head sources
and far away from flammable or explosive substances.

«Always remove the battery from the aircraft before charging.

Never charge unsupervised, stay close and keep an eye on the charger for the entire duration of the
process.

«Always allow the battery to cool down before charging, at least 10 minutes.

Overheated batteries may swell or catch fire while charging.

«Before connecting the battery, make sure the correctness of polarity

«Avoid dropping charging battery

DO NOT charge a damaged battery, if the battery have cuts, swelling or bend, do not charge.

«Dispose of damaged batteries by submerging in a pot of salt-water for 30 minutes, then give to battery

recycling place.

Power supply

. Charsoon DC-4S

Balance charger

Power adapter
14. 8V Lipo

battery j—

www.eachine.com -10-
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8.0 Ready for Flight

M4 M2
(CCW motor) — (CW motor)

@ Install propeller
Fix the 5045BN propeller (Counterclockwise)

onto the M1 (CW motor Inverted mounted)
M4 motor (CCW motor), and fix the 5045BNR
propeller (Clockwise) onto the M2(CW motor),
M3 motor (CCW motor Inverted mounted)
Counterclockwise to tighten the Black propeller
Locking Nut and Clockwise to tighten the Silver
propeller Locking Nut. Tighten the propeller
locking nut manually and make sure the
propelleris installed in proper way and fastened.

A IMPORTANT NOTES:

The side which marked characters must be up

@ Battery installation
First put the battery anti-slip matinto the bottom carbon board.
Put the battery at the bottom and move it forward-backwards as required for perfect balance and No
interference with other equipment then firmly secure the battery with the velcro strap.

O\ Attention:
(1)Place the aircraft in a wide open space, with the rear facing you.(This position is known as “TAILIN" )
(2)Put SWB switch to the 2 position (Please set the flight model to stabilize if yours are not RTF Version)
put all trims and dials to the Middle position, move the throttle to the lowest position, then turn on the
Remote Controller.
(3)A video receiving equipment is needed(such as FPV monitor with 5.8G wireless video receiver,
Goggles glasses ,etc.)to display an image and OSD information.
(4)The V-tail 210 mini-quad have a low-voltage alarm beeper. And the OSD give you a visual reference
for the remaining battery power, fight time, flight height, attitude line, flight speed, Coordinates,
direction. When voltage reach below 14.0 volts and the beeper will sound alarm. The V-tail210
mini-quad is designed for FPV racing there is no “automatic landing mode".

11- www.eachine.com
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A\ WARNING: Do not hesitate to land when you hear the alarm or see the OSD indicating 14.0 volts

V-tail 210 quick Start Guide

Latitude Longitude
{000.00000 000.00000E
GPSeerespanan Q'Qo Direction
OSD information N
. . . i r T . -
The OSD information is Filght mode=s-s-pesy STAB , 2 :
visibleon your video reciever km s H ,
*Goggles, or screen with Speed-ueoperans 0 = : e Ar% (O Height
video reiever. H :
Battery voltagessssspasss E 14.8V ARMED
ON 5.1 Quuiiinisdfans i i
min2~18' Filght Time

9.0 Motor ARM/DISARM

@® The Vtail-210 ARF/RTF was set AUX1(CH5) to ARM/DISARM the motor, the AUX1(CH5) of RTF Version
is SWA Switch, and for the ARF Version you need set up by yourself, you can also customize the
ARM/DISARM to any switch by CLEANFLIGHT CONFIGURATOR.

Modes

Use ranges to define the
range min/max will act

itches on your transmitter and corresponding made assignments. A receiver channel that gives a reading between a
the mode. Remember to save your settings using the Save button.

ARM

ANGLE

(s sange |

AUX 1Y

Min: 1300
Max: 2100

AUX2 ¥

Min: 1600
Max: 2100

@ First check that all trims are neutral, the throttle stick is

ALL the way Down with the display indicating 0%throttle.
® Push the SWA MIX switchto “2" position, you will see
all the LED light turn to blue color and the buzzer issues

Motor ARMED Motor DISARMED

a "B~B” sound, indicating that motors are armed. 1 1
Be very careful at this point, as pushing the throttle up Z i
will start the motors.You can test by pushing the stick
up a little, the motors should start.
® Push the SWA MIX switchto “1" position, you will see SWA Switch to"2" | SWA Switch to™1"

the front LED light turn to green color and the buzzer
issuesa “B~B” sound, indicating that motors are disarmed.
@ TEST: Push the throttle stick up a little, the motors will not start when disarmed.

www.eachine.com -12-
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Proximity FPV obstacle flying

Ty
"

BAA,
Ry

ﬁzﬁzﬁfiﬁ

(1)Proximity FPV obstacle flying is more suitable for experienced piots, highspeed obstacle avoidance

flights require advanced skills.
(2)Recommended FPV range 200m depending on environment.
(3)Avoid flying over people, animals, do not fly over crowds, concerts or sports stadiums. Avoid flying
close to power lines and cell phone towers as these may crash you.
® END FLIGHT
Land the aircraft, disarm(lock) the aircraft.
First Power off the aircraft by unplugging the battery, then turn off the radio.
Finally, remove the battery from the aircraft.

10.0 Firmware flsh for The V-tail 210

The following tutorial covers flashing Cleanflight Firmware onto the F3 EVO Flight Controller.
Betaflight is the same steps like Cleanflight.

® Installing the ST drivers:
(For Windows Only)
Download and install the DfuSe demo package.
Open an explorer window and browse to (assuming you' ve installed to the default path) C:\Program
Files (x86)\STMicroelectronics\Software\DfuSe v3.0.5\Bin\Driver Browse two folders deeper to the
folder relative to your Operating System version, and x86-32bit or x64-64bit variant. Click the

dpinst_x##.exe to install the driver.

Install

13- www.eachine.com
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@ Installing Cleanflight Configurator:
(For Windows Only)
Suggest to use Cleanflight Configuratorv 1.2.3 or,it’ sthe newest release.
The following assumes you also have the Chrome Browser installed.
Get the latest Cleanflight Configurator (+ Add to Chrome)

%2 Cleanflight - Configurator » B

. e
Y [ ESCRT RELATED &t
*
@3 comon e s
CrRANpEpoiT o B0n todl e
Chigviyhl S CONrol Tyrilee
x gt [ BB
—tpd PTG P [Tl P e SR g ——
i P e
i LR z » = g -
L]
i e . T " 1 of it o teied e
B 1 Ly o ol :
U T e TR W e
] B mapeet Az
s
-t e 1, 213
* LW
. = s (et

® Replacing the ST Driver with WinUSB driver:

(For Windows Only)
1.Connect the V-tail 210 to your computer through the F3 configure USB port. Open cleanflight

configurator, you should see the serial com port

Welcome 1o

CLER/IFLIGHT

Welcome to Cleanflight - Configurator, 5 utility designed to simpliy updating corfiguring and tuning of your flight controller.

Changelog -

Hardware Contributing
I yotn would like to help make Cleanflight sven better you can

Open Source / Donatlon
Naotice

The apphicabon supports sll hardwars tat canman

cizanmght (SPRacingF3, Viortex, Sparky. DaDo, REEp IR many ways, Inciiding:

CCID/EVO, Alr Hern 32 Flip32/+=/Deluxe, DragonFly32

CJMEU Microquad, Chebuzz F3, STM32FIDEcovery, Answering omer users questons on s forums and RS,

Hermit, Maze32 Tricopter Frame Siodine32 : free of charg
F iy ' sfing code 1o the firmware 2na configuraior-nsw cleanflight

Naze/32/MinlPro/Blackbox sc) PR — any f_al

The firmware scurce code can be downloaded fram here Testing new features/fixes and providing feedback
The newsst binary firmware image is available here
developmeant builds avsilsble here

supporting
FEOHESTS deyelonment by denatine
Dot utllization: D: 2% U:0% | Patketerror:0 | 12Carror 0 | CyceTime: 0 | Yo

Helping out with ssues and commenting on feature

www.eachine.com -14-
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2.Click "Firmware Flash” menu, select the latest firmware for F3 EVO flight controller and load
firmware [online] or load firmware [Local]

1.13.0 SPRACINGFIEVO 201666 2220 [stat v | st

Mo reboot sequence \

@) Rl chip erase

Manual baud rate 15200

Show unstable releases show Releasa-Candidates and Development Release

on-cleanfiight
d o Turn off yo

Portuiizatan: 0 0% U= 0% | Paketeor 0 | tacemoro | cuoenmen | 22

3.Click “Flash Firmware” and wait the ST DFU DRIVER Automatic installation.It' ssuccessfully
installed when you see the DFU port on the Up right corner.

Port ugitzatian: 0- 0% U=0% | Packsterror:0. | (¢ emor0 | cydeTimeo | 22

4.Download and launch Zadig.

15- www.eachine.com
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5.From Zadig, a.) Select Options, b.) Tick List All Devices.

. Device i Options | Help
v | ListAll Devices B.)
S5TM3.

Ignore Hubs or Composite Parents = ] [ Edit

¥
v Create a Catalog File
v

Drivell | Sign Catalog & Install Aut ted Certificat a o Informatie
ign Catalog & Install Autogenerated Certificate = WinlJSE (ibush)

— Advanced Mode libusb-win32

WeID Log Verbosity b libusbi¢

WinUSE (Microsoft)

G devices found.

6.a.) Select STM32 Bootloader from the dropdown, b.) Choose WinUSB as the replacement, c.) Click
Replace Driver. Some times the Replace progress will be slow or no response, you can close itand do it
again, you will find the dropdown is no STTUB30 but WinUSB, just click replace driver from WinUSB to
WinUSB.

[ Zadig L=l

Device Options Help
: : A.)

[STM,SZ BOGTLOADER. v]ledit
Driver  5TTub30 (v3.0.5.0) @ Winlse (v6.1,7600,16385) | = More Information
= ; WinUSB (libush)
USBID 0483 DFil libush-win32
a x C _) Replace Driver - libushi
W WinUSB (Microsaft)

b devices found.

* Credits for the Zadig option — Cleanflight Docs

® Flash Firmware
Go back to Cleanflight configurator and Click Flash Firmware
[N again after the Driver replace completed, and you will see the firmware flashed successfully!

www.eachine.com -16-
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/\Cautions

Please don't forget to select the Mixer “V-tail Quad” forthe V-tail 210 in the configure Tab after
flashed firmware

o
@le

11.0 How to install MW OSD firmware to the V-tail 210

@ Preparation

V-tail Quad v

«Download the MW OSD software pack of your choice.
*Download the Arduino flavor that matches your system.

@® Testing Firmware communication flashing
«Connect the V-tail 210 to the computer through the OSD configure USB port and power on the
aircraft with the battery
«Start Arduino IDE.
*Choose the appropriate board: Tools > Board > Arduino Pro or Pro Mini 5V, 16MHz, w/ ATmega328.
«Select the proper serial portin menu Tools > Serial Port.
+Click on the "Upload" button and observe the serial console at the bottom of arduino. Success is
noted as white text on black background stating just the binary sketch size. If messages in red letters
appear, something went wrong.

® Firmware flashing
«Connect the OSD to the FTDI adapter, and that to the PC.
«Start Arduino IDE.
«Select File > Open. Browse to the MW_OSD folder and select 'MW_OSD.ino'
*Anew Arduino IDE will appear. Close the other window as itit no longer needed.
«If you have not already done so, make sure to do the following: From the MW_OSD Arduino window,
choose the appropriate board: Tools > Board > Arduino Pro or Pro Mini 5V, 16MHz, w/ ATmega328.
Select the proper serial portin menu Tools > Serial Port.
«Edit the config.h tab to select the correct OSD hardware, Flight controller and aircraft type.
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+Click on the "Upload" button and observe the serial console at the bottom of arduino. Success is

noted as white text on black background stating just the binary sketch size. If messages in red letters
appear, something went wrong.
To test the setup, close Arduino and start MW OSD GUI. It should connect and work normally with the
newly flashed OSD.
® Updating fonts
«Connect to the OSD using the GUL
«Select the font you require otherwise the default one will be used
*The font chosen will be seen in the simulator window
«Select upload from the GUI
*NOTE - check the FAQ - requires the OSD to be powered correctly or teh fonts will not save (upload
looks OK)

@® Save OSD configuration

SETTIHGS
A\ If the OSD display is not full to the FPV screen or you changed Video format READ
by short press the HMDVR-HD, you should change the Video format in the WRITE

MWOSD GUI to match the video output. Don't forget to click “write” to DEFAULT

update after you changed the settings RESTART

12.0 How to USE Bluetooth with V-tail 210
° Enable MSP for UART3,then connect Bluetooth toUART3

(When UART3 connected Bluetooth,DSM input is unavailable), Power on the battery for the V-tail 210,
Use yourAndroid mobile phone to match with the Bluetooth.

® Download the EZ-GUI APP to your android mobilephone from Google Play, go to Settings, select
Bluetooth option and press the “Select MultiWii BT” button. The list with available devices will be
shown.Choose correct one and you are ready to go.
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